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Philip Michaels, Macworld.com

Apple had a busy 10 years. The end of
one year and the beginning of another
usually lends itself to list making. That
goes double when the second-to-last
digit in a calendar year flips over to a new
number. That’s when every writer worth
his or her salt breaks out a pad of paper,
an almanac, and a top 10 list to signify
the most important, most memorable, or
best things of a particular decade.
How successful a decade was it for
Apple? Consider that in the last 10 years,
Apple introduced the Mac mini, which offered users a low-cost desktop option; Safari, which took the pain out of Mac-based
browsing; and iChat, which changed the
way we communicated with others—and
none of those made my Top 10 list. That’s
the sign of a company that had a lot going on from 2000 to 2009.

10. Apple introduces iPhoto (2002)

What happened: At the 2002
Macworld Expo, Apple showcased iPhoto, a free program
for managing digital photos.
That original release was missing a few features—it’s certainly a far cry
from the latest version of iPhoto and its
ability to organize images through facial
recognition technology. But at the time, it
brought a level of simplicity and organization to the increasingly popular world
of digital photography.
Why it matters: Digital imaging boomed
in the past 10 years, to the point where
even novice shutterbugs tote around multimegapixel monstrosities. Apple recognized
the growing interest in digital cameras early
on and gave users a tool that helped them
get more out of their images.
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Tech world waits for Apple to Insanely bad: Ten Apple duds
show them how to make
of the decade
tablet computers
01.09.10
MacDailyNews

?

Apple has a knack
for spotting problems
we didn’t know we
had. It can leave us
wondering how we
survived without vast
libraries of music and
TV shows in our pockets or the comfort
of knowing “there’s an app for that.”
Now, speculation is growing that in
two weeks Apple will unveil a tablet-style
touch-screen computer that is bigger
than an iPhone but smaller than a standard laptop. If indeed that is Apple’s next
move — the company won’t comment —
it would have to show us why we ought
to pay for yet another Internet-connected
screen, on top of the TVs, computers and
smart phones we already have.
Tablets, also called slates, are one-piece
computers with big screens and no keyboards, though some models can convert
from a regular laptop to a tablet by flipping
the screen around to hide a keyboard.
Such devices have been around since
the early 1990s, including one from Toshiba Corp. that weighed 3.3 pounds and
cost about $3,500. But tablets haven’t
seen much success in the mainstream. At
the peak in 2007, manufacturers shipped
about 1.5 million tablets worldwide —
less than 1 percent of the personal computers shipped that year, according to
the research firm IDC. Only about onethird of those tablets were for consumers.
The rest were used in specialized settings
such as doctor’s offices or warehouses.
Bill Gates, co-founder of Apple nemesis
Microsoft Corp., predicted repeatedly during
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Editor’s Note: As great a decade Apple may
have had, not every product to come out of Cupertino hit its mark. Simon Jary of PC Advisor
and Macworld UK looks at 10 Apple duds from
the past 10 years.

Apple has had an amazing decade,
revolutionizing industries as diverse as
music, movies, telecoms, and software
with its iPod/iTunes/iPhone products and
ruling the OS Wars with its much-copied
Mac OS X.
Apple CEO Steve Jobs won PC Advisor’s
Person Of The Decade. Fortune magazine
named him CEO Of The Decade.
Could the man do no wrong?
Oh, yes he could do wrong. Very wrong.
Here’s our list of ten products—in no
particular order of badness—that Apple
and Steve Jobs probably wish had never
seen the light of day.

Power Mac G4 Cube: Too cool for tool

Following the success of its
funny-looking bubble-shaped
iMac what did Apple do next?
Come out with something
even wackier?
A completely spherical ComputerBall
that you could roll between workgroups?
Something that looked like a fish?
No, it waited until 2002’s crazy anglepoise iMac for its next doolally design.
Did it go mad on the colours and unveil something truly hideous? No, you’re
thinking of 2001’s Flower Power iMac.
What Apple did was quite the opposite
of the cute, friendly iMac. It designed the
über-cool Power Mac G4 Cube, distilling all
the power of the old tower-based Power
Mac into a clear, eight-inch perspex cube.
Where the iMacs were fat, fun and
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9. Apple opens its first retail stores (2001)

What happened: In May 2001, Apple
launched retail stores in Tysons Corner, Va.,
and Glendale, Calif., with the idea of opening 25 retail outlets by the end of the year.
By the end of the decade, Apple would
have 273 stores around the globe, including outposts in London, Paris, and Beijing.
Why it matters: Apple’s goal in launching
a brick-and-mortar retail effort was to reach
customers who might not otherwise consider
buying a Mac.“We want to convince the other
95 percent that Apple offers good products,”
Apple CEO Steve Jobs said back in 2001.“If only
5 of 95 people in this group become Mac users, we’ll double our market share.” It would be
hard to dispute that the Apple Stores helped
the company build its customer base. Consider
the third quarter of Apple’s 2009 fiscal year: the
company sold 492,000 Macs at its retail stores,
with half of those computers bought by new
Mac customers.

8. The iTunes Music Store debuts (2003)

What happened: Apple opened the doors
to its online music retail service in April 2003,
launching the iTunes Music Store with 200,000
songs that users could download for 99 cents
each. The store is slightly larger now—in
2008, it became the top music retailer in the
country. And it now offers TV shows, movie
purchases and rentals, and DRM-free music.
Why it matters: There wasn’t much to online music retail before the iTunes Store came
along—why buy a song when you can find it
on a file-swapping site for free? But the quality of iTunes music and the ease with which
you could download them helped popularize
buying music online. And all that digital content didn’t exactly hurt iPod sales either.

7. Apple opens up the iPhone to
third-party developers (2008)

What happened: Software makers who
wanted to build something that could run
on the iPhone had one Apple-approved
option in the first year after the iPhone’s release—make their application Web-based.
That changed in 2008 with the iPhone
software development kit, which gave developers the tools to make native mobile
apps for the iPhone and iPod touch. The
App Store opened that June with 552 apps.
These days, that number tops 100,000.
Why it matters: The iPhone has a lot of
things going for it, as we’ll see below. But

one of the things that sets the iPhone apart
in a crowded smartphone market is the
depth and quality of the third-party apps
that support it. Apple has some kinks to
work out of its approval process and App
Store organization, but the company absolutely made the right decision in opening
its mobile platform to developers.

6. Apple introduces the Aluminum
PowerBook G4 (2003)

What happened: Apple kicked off 2003
by declaring it the ”Year of the Laptop”—
and the company wasn’t kidding around.
It introduced 12-inch and 17-inch versions
of the PowerBook G4 that year, with both
configurations housed in a new anodized aluminum enclosure; 15-inch models
would follow by year’s end. With a few minor modifications, that design would remain in place for the rest of the decade—
even the justly-praised unibody design
that houses Apple’s portables these days
maintains the elements of those aluminum PowerBooks. What’s more, Apple
continues to offer the small, medium, and
large options in its laptop line.
Why it matters: The Aughties turned out
to be the decade we went portable. Performance improvements made laptops every
bit as appealing as their desktop counterparts.
And this 2003 release from Apple helped set
the tone. The company reaped the rewards of
our newfound appreciation for mobile computing—laptops now represent more than
two-thirds of the Macs Apple sells and have
helped the company routinely smash its own
quarterly sales records.

5. Boot Camp lets Intel Macs
boot Windows (2006)

What happened: Once Apple started building Macs powered by Intel-designed
processors—more on that momentarily—it
didn’t take much to get Microsoft’s Windows
operating system running on Mac hardware.
That turned out to be Boot Camp which let
Intel-based Mac owners boot directly into
Windows XP. Boot Camp is now built into
Mac OS X, while third-party developers offer
virtualization software that let you run Mac
and Windows on the same machine.
Why it matters: The ability to seamlessly
run Windows on a Mac removes one more
obstacle that might otherwise keep corporate IT departments from letting their
employees use Mac hardware. Boot Camp
and third-party virtualization offerings

make the Mac a more attractive
option in settings where the Mac
never would have been welcomed
at the start of the decade.
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4. Apple begins the transition to Intel
processors (2005)

What happened: Steve Jobs dropped a
bombshell in his 2005 Worldwide Developer
Conference keynote when he announced
that Apple would drop PowerPC processors
in favor of Intel chips. Apple would introduce
its first Intel-based machines six months later,
in the form of the iMac and the MacBook Pro.
By the 2006 WWDC, Apple completed the Intel transition with the release of the first Mac
Pro. And the Mac OS X update released this
year only runs on Intel-based hardware.
Why it matters: The PowerPC processor
had gone about as far as it could go. Switching to Intel chips opened new possibilities
for Apple, and the company has delivered
with a steady stream of updates that have
the Mac in exciting new directions. And, as
noted above, Intel-based hardware can run
Windows, making the Mac a more attractive option for businesses.

3. Apple releases the original iPhone
(2007)

What happened: It was easily the most
dramatic moment of the decade: At the
end of his January 2007 Macworld Expo
keynote, Steve Jobs reached into his pocket and pulled out the first iPhone. It’s safe
to say that Apple—and the mobile phone
market as a whole—hasn’t been the same
since. In the two-plus years and two iPhone
updates since that moment, Apple has sold
more than 33 million phones with no signs
of slowing down any time soon.
Why it matters: Like another Apple portable device we’ll get to in a moment,
the iPhone was a game-changer—both
for smartphones and for Apple itself. Any
smartphone to come down the pike these
days invites inevitable comparisons to
the iPhone. Meanwhile, Apple has found
itself another source of revenue to go
along with its Mac and music businesses.

2. Mac OS X 10.1 comes out (2001)

What happened: Apple actually overhauled its Mac operating system in
March 2001, replacing the classic Mac OS
with OS X. OS X 10.1—“Puma” to its close
friends—would follow later that year,
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regular computer tasks such as editing a
spreadsheet was more cumbersome than
and while the Aqua interface and Cocoa using a mouse and keyboard.
and Carbon APIs that marked the new OS
No one has given up on tablet computers
were already in place, this version intro- running Windows; several cropped up
duced the improvements that made OS last week at the International Consumer
accessible to most users.
Electronics Show in Las Vegas, including
Why it matters: For Apple’s core Mac busi- prototypes from Hewlett-Packard Co. and
ness, nothing matched the impact of the Dell Inc.
switch to OS X. It paved the way to wider
But it seems it will be Apple CEO Steve
use of the Mac platform and set a standard Jobs who swoops in with a tablet that
that forced other OS makers—we’re look- takes advantage of recent technology iming in your direction, Redmond—to step up provements and garners the most buzz.
their game. Honestly, I could have picked any
Dell and HP didn’t present a retail-ready
of the OS X updates that Apple ushered in tablet because the companies want to be
throughout the decade, but in this scribe’s able to adjust if Apple’s vision turns out
opinion, 10.1 was the version that signaled to be radically different, says computer
Apple’s new OS was ready for prime time.
industry analyst Roger Kay of Endpoint
Technologies Associates.
1. Apple releases the first iPod (2001)
“If Apple blows it out of the park, we
What happened: At an October 2001 know that that’s what the space is going
press event at its Cupertino headquarters, to look like for a while,” he says.
Apple unveiled a music player with enough
While older tablets weren’t pitched as
capacity to hold 1,000 songs. The portable Internet-surfing devices, modern ones
music player soon became ubiqwill be able to take advantage of nearuitous—adding Windows comubiquitous wireless Internet access, as
patibility in 2002 certainly helped
well as our growing willingness to pay for
in that regard. And even with
monthly data plans for smart phones and
iPod sales growth slowing down,
little netbooks.
Apple still routinely sells 10 million music
Touch screens and the underlying software
devices a quarter—unless it’s during the are also dramatically better today, and
holidays, when that sales figure doubles.
we’ve gotten used to pinching, swiping
Why it matters: Mac purists may shudder and using on-screen keyboards thanks to
at the thought, but the iPod indicated that the popularity of Apple’s iPhone.
Apple was more than just a computer comAnd gadgets — especially ones made
pany. The device established the company as by Apple — are thinner and sleeker all
a leading player in the digital decade, when the time, making them more portable
we began to rely less on physical media for than clunky early tablets.
our entertainment and more on digital files.
We’ve seen this happen before: Portable
As the iMac helped revive Apple’s fortunes music players and “smart” phones had
in the previous decade, the iPod padded existed before the iPod and the iPhone
Apple’s profits, setting the tone for a success- came along, and yet it was Apple that reful—and lucrative—decade to come.
defined those categories.
But that’s just one man’s list. I’m sure
Still, an Apple tablet could have a hardthere are plenty of other milestones from er time becoming a mainstream success
the last 10 years that I’ve overlooked.
than those gadgets, if only because there
is not necessarily a compelling reason for
Continued from page 1 one.
In the absence of confirmation from
Apple, analysts have many guesses about
how Jobs would position an Apple tablet.
the 2000s that tablets were about to take Some think it will simply be an oversized
off. He was wrong because those tablets iPod Touch, a music player that is also used
required people to use a pen-shaped stylus to view movies, family photos and other
to tap buttons or write on the screen, which content on the go. Others believe Apple
was attractive in workplaces where employ- is building the tablet with an eye to the
ees needed to check boxes or fill out forms. burgeoning electronic book market (even
For most people, though, using a stylus for though Jobs said in 2008 that “people

Apple Tablet?

Continued from page 2

?

don’t read anymore.”) Still others
position it as a companion screen
to use while watching television —
the tablet would deliver information related to the program airing on the TV.
But the mechanics of the human body
may be stronger than Jobs’ charisma.
We tolerate devices like smart phones
with their tiny screens and awkward keyboards because they’re fine for what we
need them for — quick, on-the-go reading and messaging. As soon as the screen
gets bigger, though, people tend to start
wanting to do more with the device, such
as typing longer missives, says Mark Rolston, chief creative officer for Frog Design,
a firm that designed one of Apple’s first
computers. At that point, the limitations
of small screens and the lack of a real keyboard could be intolerable, and people
would move up a rung to a small laptop.
Jon Gibs, vice president for media insight
at The Nielsen Co., says he can’t think of a
situation in which a tablet screen would
be the best one available for watching
video. At home, the TV is the more natural choice, while on the go, a pocket-sized
iPhone would be more convenient.
Rolston believes Apple won’t market a
tablet as a replacement for a workhorse
laptop. Instead, Jobs will describe a limited set of uses for the device at first, Rolston says, and later Apple may broaden
how it advertises the tablet. He pointed
to the way the iPhone evolved from easyto-use phone to multipurpose pocket
computer a year after its debut with the
advent of the App Store, which sells addon software of all sorts.
Perhaps some of the biggest hopes for
tablets are bubbling in media companies
that have failed to capture enough advertising on the Internet and now crave a
new way to sell interactive content. Something like Apple’s iTunes program, which
lets people buy songs, TV shows and
movies to put on their iPods and iPhones,
could be used to distribute newspaper
and magazine stories or TV programming
on a tablet.
Already publishers are flocking to e-book
readers such as Amazon.com Inc.’s Kindle,
but photo and graphics-rich magazines
and video or multimedia installments
from newspapers don’t look very good
on the e-readers’ black, white and gray “eink” screens.
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Continued on page 8

Insanely bad

Continued from page 1

colourful the G4 Cube was sleek and
neutral—surely this was a true Steve Jobs
product.
It looked so good that it was immediately installed in New York’s Museum Of
Modern Art.
While undoubtedly a remarkable feat
of engineering, the G4 Cube didn’t last
long—production was suspended less
than a year after launch (August 2000). Instead of being embraced for saving desk
space the Cube was avoided because
it was so small and too cool for its own
good. And bloody expensive.
Apple was criticised for leaving too
much out—PCI expansion, internal audio
input and output—but maybe it was just
too radical for a beige-bound industry
still reeling from the chubby iMac.
Nice try, but hardly a roaring success.

iPod 3G: Button it

The original 5GB iPod (October
2001) is a design classic, and most of
its later versions—all the way to today’s iPod classic—enhanced its minimalist
beauty. But Apple had a very early blip with
the third generation (released April 2003).
Unlike with the G4 Cube, which had Steve
Jobs’ hands all over it, this product upgrade
looked like it slipped right past his office
while he was out.
While thinner and lighter than the original iPod (with up to eight times the capacity) this new iPod ruined the classic minimalism by adding a row of four indented,
backlit buttons above the scroll wheel.
It was ugly, and made us fear that the next
iPod would have even more buttons and end
up looking like every other MP3 player on the
market. Worse, it might have morphed into
something resembling a portable CD player.
A year later Apple ditched the stupid
buttons for a solid-state click wheel, back
to the look of the simple original.

iPod nano v3: naNO!

The original iPod nano (Sept.
2005) was a sleek beauty. Version
2 (September 2006) was a very dull version of it, but version 3 (September 2007)
was quite the reverse. Gone was the long,
skinny body in favour of something, well,
stubby. It quickly got nicknamed “Fat
Boy”—possibly in homage to the early
nuke, so horribly did it tarnish the nano’s

former good looks. A year later it was
gone, and the skinny nano was back.

Apple TV: Brains turned off

Steve Jobs once put down the television
as uninteresting: “We think basically you
watch television to turn your brain off,
and you work on your computer when
you want to turn your brain on.”
But along came Apple TV, a product
that even today still feels half loved.
It was first announced in September 2006
as iTV—a product name that immediately
damned it in the eyes of the Britsh, where national TV station ITV is famous for its lame dramas, dreadful comedies, and even adverts!
Its name also clashed with a Mac accessory,
Elgato’s EyeTV. Everything about this product
began to look a bit rushed and ill-thought out.
iTV/Apple TV was a telly-bound version
of Apple’s Front Row media centre Mac
software. It got another mention the following January at Macworld Expo and it
started shipping a couple of months later.
I’m always suspicious of Apple products announced well ahead of schedule, and the notion of Apple TV as a bold new product had
certainly waned by the time of its release.
While our homes have welcomed DVRs
such as the TiVo or Sky+ the Apple TV is
probably found only in Mac journalists’
dens. It lacks a TV tuner, which frankly
cripples it from the off.
The Movies “Search” feature searches
only iTunes Store movies. iTunes movie
rentals can be transferred to any videoenabled iPod, iPhone or Apple TV for
playing, but any movie rented on Apple
TV must be watched on Apple TV.
To copy a movie purchased on Apple
TV to a video-enabled iPod or iPhone, the
movie must first be transferred to an iTunesenabled computer on the network. Apple
TV/iTunes is “not designed” to sync or stream
content from networked drives to Apple TV.
Content that can be synced or streamed
to Apple TV has to be on the local drive
or an external drive directly connected to
the iTunes-enabled computer.
Maybe Apple had its brain turned off
when it was meant to be making this a
great product. Frankly I’d rather watch ITV.

MobileMe: MobileMess of a Launch

Apple started the decade with the release of some ace, free online services,
called iTools. A year later it had changed
this name to .Mac, and it wasn’t free any

more. In 2008 Apple changed its
name again—never a great sign
for a product’s integrity or longterm prospects—this time to MobileMe.
.Mac was never going to appeal to Windows users, although I’m not sure that
MobileMe will either.
MobileMe was launched as the “Microsoft
Exchange for the rest of us”—it wasn’t
Apple Marketing’s greatest hour either,
was it?
Changing a product’s name is clumsy,
but when that name is also part of your
email address it becomes maddeningly
stupid.
You could still use your @mac.com address at the same time as your new @
me.com address, so at least there’s some
change delay built in. But it confused current users greatly—as did the removal
of favourite services such as the fun and
friendly iCards and tremendous HomePage web publishing.
Worse still, the MobileMe launch was
surely Apple’s most botched ever. For
weeks after launch, over 20,000 subscribers weren’t able to access their email
through MobileMe.
The free trial of MobileMe inadvertently
charged some Australian and European
customers’ credit cards, leading Apple to
issue refunds and extend the free trial to
four months.
It got so bad that even Apple eventually admitted it was a colossal cock up.
Steve Jobs nearly said sorry.
In an internal e-mail sent to Apple
employees on August 4, 2008 Jobs admitted that MobileMe was launched too
hurriedly and “not up to Apple’s standards”.
He wrote that “it was a mistake to launch
MobileMe at the same time as iPhone 3G,
iPhone 2.0 software and the App Store”.
On August 18, 2008, it was announced
that MobileMe subscribers would be offered a 60-day extension in addition to
the one-month extension previously offered.
In a word, shambles.
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Mac OS X 10.4 Spotlight: Stop or I’ll shoot!

Mac OS X has to be one of the great
tech products of the decade, spawning
such promising offshoots as Windows 7,
for instance. Each version is named after
a cat. How cute! Microsoft appears to ran-

Continued on page 7

Four Essential PDF Tips for
Snow Leopard
Kirk McElhearn, Macworld.com

PDF files are practical and easy to work
with, not only because they retain the layout
of your documents, but also because users on any platform can view them. When
you want to share documents with others,
even if they don’t have the software you
used to create the documents, PDFs are
the natural choice. Here are four tricks everyone should know for using this versatile
file format with OS X 10.6 (Snow Leopard).

1. E-mail PDFs with one click

Whenever you print something in OS
X, you’ll see a PDF button at the bottom of the Print dialog box. Click on this
and choose Save As PDF to quickly save
any document as a PDF. But that’s not all
you can do. Look again at this menu and
you’ll see you can also save and mail a
document with a single menu selection.
When you have a file you want to share,
just press Command-P, click on the PDF
button in the Print dialog box, and then
choose Mail PDF. Your Mac will create the
PDF, launch Mail (or your default e-mail
program) if it’s not already open, and
then create a new message and add the
PDF as an attachment. All you need to
do is enter an address, subject, and some
comments. Done!

2. Save a page (or three) from a PDF

Sometimes when you’re working with
a large PDF document, you want to
send only a page or two to a friend or
colleague for review. It’s a snap to save
single pages, or even multiple pages,
from a PDF. First, open the PDF in Preview
(in your Applications folder). Reveal the
sidebar by clicking on the Sidebar button on the Preview toolbar (or by pressing Command-Shift-D). You should see
a thumbnail of every page in the document. If you don’t, click on the second
button from the left at the bottom of the
sidebar (or press Command-Option-2).
Find the page you want to save, and then
drag its thumbnail from the sidebar to a
Finder window or to your Desktop. If you
want to drag multiple pages, select them
(Shift-click to select adjacent pages, or
Command-click to select non-contiguous

Left or Rotate Right. Now you can
hold your laptop like a book (screen
in one hand; keyboard in the other).
Flip the laptop to choose which side you
want the screen on for easy reading.
If you use Adobe’s free Adobe Reader,
you can go one step further. Choose View
-> Rotate View -> Clockwise (or Counterclockwise), then press Command-L
to enter full-screen mode. Flip pages by
pressing the spacebar, or go back a page
by pressing Shift-spacebar. You can read
PDFs like this without the distraction of
menus and toolbars, and make the content as big as your screen can hold.
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pages) and them drag them the same
way. Whatever you select and drag to the
Finder will be saved as a PDF with the
name PDF name(dragged).pdf.

3. Merge PDF pages

Sometimes you end up with a bunch of
small PDFs that you’d like to put together as
one file. This is easy to do, but the process
has changed between OS X 10.5 (Leopard) and Snow Leopard. First open one
of the PDFs with Preview, and display the
sidebar with thumbnails (as described
above). Under Leopard, you could just
drag one PDF-be it a single or a multiplepage document-into place below another
to add it to that file. Saving the document
would save the two PDFs together as
one. With Snow Leopard, however, there’s
a new trick that’s not documented.
Instead of dragging the second PDF
onto the sidebar below the first one, drag
it on top of the first one. This changes the
display of the first PDF in the sidebar.
Click on the arrow button to“close”or“open”
the PDF, toggling between showing just its
first page and all the pages it contains.
This makes it easy to make sure you’ve
put the documents in the right order.
When you press Command-S to save the
document, Preview will save the whole
thing within the document of the first
PDF file that you opened. (Alternatively,
you can save it as new document by
pressing Command-Shift-S and choosing
a new name.)

4. Read PDFs more easily on a laptop

On the small screen of a laptop, PDFs
formatted in portrait mode can be hard
to read, especially if they contain multiple
columns. It’s a pain to scroll up and down
to go from one column to the next. You
can, however, read them like books on a
laptop. In Preview, choose Tools -> Rotate

Another way to securely
delete the trash in Snow
Leopard
12.15.09
Rob Griffiths, Macworld.com

Here’s a very simple
but potentially useful
Snow Leopard tip. As
you probably know,
you can set up the Finder (in both 10.5
and 10.6) to securely empty the trash
by default. You do this in the Finder’s
Preferences, on the Advanced tab.
But what if you don’t always want to
empty the trash securely? If you want to
do it on a one-time basis, you can use the
Finder -> Secure Empty Trash menu item.
(If you do this a lot, you can make a keyboard shortcut for that item, using the
Keyboard Shortcuts tab of the Keyboard
System Preferences panel.)
Here’s one other option, especially
for those of you who prefer to use the
mouse: You can securely empty the trash
from the Trash icon in the Dock (this only
works in Snow Leopard). Hold down the
Command key, and then click-and-hold
(or right-click) on the Trash can icon in
the Dock. When the Trash’s Contextual
Menu appears, it will read Secure Empty
Trash (instead of the usual Empty Trash).
Select Secure Empty Trash from the contextual menu, wait a while (a long while if
the trash has a ton of stuff in it), and your
trash will be securely emptied.

Buying a printer:
fact vs. fiction
Dispelling (and, sometimes, confirming) the
conventional wisdom about printers.
by James Galbraith, Macworld.com

Buying a printer would seem to be
straightforward: Decide what you need
the printer to do—text? photos? scanning, copying, and maybe faxing?—and
you’ll have a good idea of what kind of
printer you need.
Unfortunately, connecting those dots
isn’t always so easy. That’s because the
printer market is rife with conventional
wisdom that isn’t always wise at all. Here
are a few of the most common printer
myths and my take on whether or not
they’re really true.

Inkjets do a bad job with text

Not true. Most inkjets print perfectly
legible text. But for documents the public
will see, such as resumes and brochures,
it’s hard to beat the
clean and sharp
characters produced
by a laser.
The problem is
technical: If you spray a liquid (such as
ink) on a porous surface (such as plain
paper), that ink is going to bleed into
areas where it shouldn’t, making for lessthan-optimal text and other fine lines.
If you had unlimited space and money, you
would buy a laser for text and an inkjet for
photos. Most of us, however, live in the real
world and have to choose one or the other. If
you like to print photos at home, that choice
will most likely be an inkjet printer.
To help get the best possible text out of
your inkjet, try using better quality paper.
Many companies sell presentation papers
for their inkjets that allow less ink-bleeding.
Also, make sure to check that your printer
driver is set for best results-high or fine quality—and that proper paper type is selected.

Image quality from multifunctions is poor.

Not really true. Because they combing
printing, scanning, copying and (sometimes) faxing into one machine, multifunction printers have become wildly
popular. But do you sacrifice quality for
convenience? Probably not.

These all-in-one devices are often built on
the same print engines as stand-alone printers. Some, in fact, look like the vendor just
glued a scanner on top of a standard ink-jet.
In such multifunctions, print quality is identical to the stand-alone version of the printer.
The only catch is that manufacturers
don’t make multifunction versions of their
highest quality printers. High-end printers
used for fine art and archival prints can use
specialized inks and print on a wide variety
of papers. So, for example, Epson’s Stylus
Photo ink jet printers can cost as much as
$800; the Stylus Pro models start at $1300.
Yet Epson’s highest end multifunction—
the Artisan 810 All -in-one Printer—costs as
little as $200 (Best Current Price). Its output
will clearly not be in the same league as
that of the Stylus Photo or the Stylus Pro

You need an Airport base station to
share a printer.

Not true. Plugging your printer directly
into the USB port on an Airport base station is a convenient way to share a nonnetworked printer, but it isn’t the only way.
Many printers, even those on the low end,
now offer both wired and wireless Ethernet printing options. But the easiest way to
share your USB printer over your local network is to enable printer sharing in the Print
and Fax System Preferences. Once that’s
setup, other computers on your network
can see your shared printer via Bonjour in
their Print and Fax System Preference.

Lasers are hazardous to your health.

Possibly true. A study published by the
Queensland University of Technology
several years ago found that laser printers
emit tiny particles into the air. The resulting particulate pollution is comparable,
under certain conditions, to the air near
a busy road. Emissions rates were found
to vary by the vendor and the age of the
printer. Follow-up research indicated that
those emissions have
something to do with
the paper being heated inside the printer,
before the toner is
applied.
In theory, those ultrafine particles emitted by lasers could
have the same kinds of health effects as
other small particles—such as those in
cigarette smoke or polluted air. But those
health hazards have not yet been defini-

tively established. In the meantime,
researchers recommend moving
printers, particularly those that get
heavy use, away from areas where people
sit; wherever you put your laser, it should
be well-ventilated areas.
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Which Companies Really Sell
Greener Electronics?
01.08.10 AppleLinks

Apple is leading the way on eliminating toxic PVC and BFRs from all it’s new
products with the new iMac and MacBook being the first PC’s completely free
of PVC and BFRs
Greenpeace’s ranking guide, published
since 2006, shows clearly how the 18 top
consumer electronics companies line up.
This new chart shows which of those companies have eliminated the most harmful
chemicals from their product ranges.
Gold stars represent products free of
the worst hazardous substances. Smaller
stars mean there are lmited products free
of worst hazardous substances. A grey
star means none of the products made by
this company in these product categories
are free of worst hazardous substances.
And finally, a dash means that the company doesn’t make that kind of product.
See the notes below for more information about each company.

Continued from page 4

domly pick names for its OSs, and Linux
versions all appear to come from a language that makes Finnish sound comprehensible.
Before OS X Mac users used to find things on
their hard drives using something called Find.
Such intuitive naming is below the
amazingness that is OS X. All of its tools’
names must be subtle puns on standard
functions so Apple’s software designers
can sculpt beautiful icons for them.
Find was lost, but with Mac OS X 10.4 Spotlight was switched on. When I think of spotlights it’s not the stage that springs to mind but
WW2 prison camps, daring escapes and evil
Nazis. Maybe that’s just me, but it immediately
made me suspicious of Spotlight’s intentions.
This wasn’t helped by Apple trying to
cram too many symbols and smug wordplays into its software. OK, I’ll grudgingly accept the term Spotlight, but why is its icon a
magnifying glass? Why not call it Detective
or insect collector? Or how about Sherlock.
That’s witty and smart, and, oh…
That doesn’t make Spotlight a dud, but
what did—especially in Mac OS X 10.4—
was its sub-glacial speed and ability to
find tens of thousands of email documents with apparently no relation to
what I’m looking for, but not the simple
PDF that I misplaced.

ROKR: What a SHOKR

Before the wonderful iPhone came Apple’s
first mobile—the ROKR, made with Motorola.
Perhaps we can blame Motorola, then, for one
of the ugliest mobile phones ever released.
It was the first phone to play music
from iTunes and operate somewhat like
an iPod. Other than that it was junk.
To stop it cannibalizing iPod sales it was
restricted to holding a mere 100 songs. It
was very slow to sync, too - even with just
100 songs to send down the non-fast USB
connection.
Apple may now try to pretend that this
was just a Motorola product that it had
nothing to do with, but why then was it
unveiled at a special Apple event in September 2005?

iPod Hi-Fi: White elephant

No one can make a music player as well
as Apple, but why did the company decide
to attack its accessory market head on
with the lumpen iPod Hi-Fi?

All the best audio boffins created iPod
speaker systems, but as usual Apple
thought it knew best. It didn’t.
Released in February 2006 the iPod Hi-Fi
had little going for it except the Apple
logo.
It was super expensive ($349), especially
for a system that lacked a radio and even
a video-out port. Even the Bose SoundDock was cheaper.
The iPod sat on top of the unit, making it vulnerable to being knocked off or
crushed.
The remote control could only skip between tracks within the selected playlist.
The menu button couldn’t even assume
the function of the menu button on the
docked iPod itself.
Not all iPod were compatible with it,
which at least meant that a good proportion of iPod users didn’t even have to
consider this white elephant. The system
also lacked a USB port for connecting a
docked iPod to a computer for syncing.
Newer iPod models and the iPhone
3G/3GS can’t be charged on the Hi-Fi because they require a lower voltage—the
iPod Hi-Fi supplies 12v (FireWire) while
the newer devices expect 5v (USB).
As for sound quality the iPod Hi-Fi got
canned. It didn’t help that Apple boasted
of its “audiophile quality sound”. As we
wrote at the time: “the Apple iPod Hi-Fi
lacks upper treble detail, which, combined with slightly elevated midrange
levels, makes the very highest frequencies difficult to make out at times. The HiFi’s other limitation is that it can’t really
overcome its one-piece design to provide
expansive soundstage and precise stereo
imaging.”
After a year and a half Apple quietly
discontinued the iPod Hi-Fi, handing
the market back to people who actually
knew something about designing audio
products.

iPod socks: Smelly feat

But Apple wasn’t finished scaring its
iPod accessory makers. There are thousands of iPod cases out there—some officially endorsed, the majority not—but
none was as hideous as the iPod Sock.
This knitwear absurdity was thought to
be joke on launch (December 2004) but
its reality does at least hint that some
decision-makers at Apple still take the
occasional drug or three.

iPod Socks come in packs of six—
either in case you have six iPods
or your iPod sweats like a jogger’s
foot. Apple still sells these things. Where
in Steve Jobs’ design aesthetic did these
things spring from?
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Mighty Mouse: Dirty rat

Apple is famous for inventing the
world’s worst mouse—
the original iMac’s socalled
Hockey
Puck
mouse, which was small
and round and crap.
And the company has a lot of previous
in the odd input department. While everyone else added a second button or
seven plus a handy scroll wheel for added
functionality and ease of use, Apple stuck
doggedly to its one-button, two-click
philosophy. Result: anyone sane went
and bought a mouse from Microsoft or
Logitech.
Apple finally relented and designed
some decent mice. The Pro Mouse (July
2000) even had hidden multiple click
functions. But we waited years before
Apple added a scroll wheel.
The Mighty Mouse (August 2005) had a
little scroll ball that looked just great. You
could even scroll diagonally! But after a
few weeks of loving it, the Mighty Mouse
sprang its nasty surprise - the scroll ball
stopped working.
Either Up or Down just froze because
it got clogged up with dirt. OK, that dirt
was off our hands but the fact that it
stopped doing what it was supposed to
do at the most annoying moments soon
spelt Apple Dud.
You’re really not meant to have to blow,
lick or spit at your tech, but it was a twoway thing. We blew. It sucked.

How am I doing?
I have been editing the Vaporware
Gazette since March. Take a minute to
answer 5 questions for me:
1. Do you read the Gazette monthly?
2. If so, is it timely?
3. Are the “TarMac Tips” useful?
4. What is lacking?
5. Is electronic distribution OK?
Any other comments are welcome!
Send answers to:
smittysprintshop@me.com
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Insanely bad

Greener “Notes”

Continued from page 7

Apple : Apple is leading the way on eliminating toxic PVC and BFRs from all it’s new products
with the new iMac and MacBook being the first
PC’s completely free of PVC and BFRs.
Nokia: Almost all of Nokia’s new models of mobile phones are free of BFRs. Nokia’s new models
have been free of PVC since the end of 2005, and
it is now aiming to have all new models free of
all brominated and chlorinated compounds and
antimony trioxide from the start of 2010.
Sony Ericsson: Sony Ericsson has also
already banned toxic antimony, beryllium
and phthalates from new models launched
since January 2008.
HP: HP is fast catching up with Apple
lead in PVC and BFR phase out and is well
ahead of Dell and Lenovo.
Acer: Acer needs to expand this range
in 2010 to all its products.
Toshiba: Toshiba has some laptops, phones
and TV’s partly free of PVC and/or BFRs but
needs to match it’s competitors products
without PVC and BFRs in these product categories. Toshiba has also committed to introduce alternatives to phthalates, beryllium and
antimony by 2012 in all its products.
Dell: Dell has postponed phase out of
PVC and BFRs till 2011, only offering models
with “reduced” amounts of PVC and BFRs.
Leveno: Lenovo has postponed phase out
of PVC and BFRs till 2011, only offereing models with “reduced” amounts of PVC and BFRs.
Samsung: Samsung needs to remove
PVC and BFRs across much more of its
product range.
LGE: Only LG mobile phones will be free of
toxic PVC and BFRs from 2010; TVs, monitors
and PCs have to wait until 2012 and household appliance models until 2014. LGE has
launched its first mobile phone that is free
from PVC and BFRs and has six models of
halogen-free Optical Disk Drives.
Fujitsu: Fujitsu has only some reduced PVC
and BFRs models and is behind competitors
in removing these substances from PCs.
Sony: Sony has only some reduced PVC
and BFRs models and is behind competitors
in removing these substances from PCs.
Motorola: Well behind Nokia, Sony Erricsson
in removing PVC and BFRs from all its phones
Panasonic: Panasonic has some products free of PVC or BFRs but not in these
product categories and has no commitment to remove these toxic substances
across its product range.

Apple Tablet?

Apple-designed tablet to be revealed later this month, the next
version of the iPhone is getting its
A tablet with a color screen, howshare of buzz as well,” Chris Foresman reever, could create new opportuniports for Ars Technica.
ties. Sports Illustrated published a
“We have already seen some evidence
video online of a tablet-based digital maga- that Apple might bump the iPhone’s
zine that lets readers glide through content, camera up to five megapixels, but there
jump from a single photo to an entire gal- is also evidence to suggest the compalery, view features and ads with embedded ny may add an LED ‘flash’ to improve its
video segments, and play games on the tab- low-light picture-taking abilities,” Foreslet that tie into sporting events on TV.
man reports. “Imagination Technologies,
Wired magazine is working on a made- the company that develops the PowerVR
for-tablet edition. While the business model graphics processors used in the iPhone,
isn’t final, Wired will likely charge a subscrip- has also announced an improved SGX545
tion fee for some or all of the tablet version, graphics processor core... Imagination
says editor-in-chief Chris Anderson.
says that the tech is already ‘licensed by
Smart phone screens are too small a lead partner,’ and Apple’s investment in
for long-form reading and high design, the company certainly qualifies it as one
while PC screens require people to lean of those partners.”
in across the keyboard to read. A tabForesman reports, “Finally, The iPhone
let would have both the intimacy and Blog reports that buzz around the CES
the screen real estate to approximate a show floor is that Apple plans to add
magazine experience, Anderson says.
some form of limited multitasking to the
“We decided this was the big one,” next version of the iPhone. The details are
Anderson says.
naturally non-specific, though Apple has
Apple’s stock more than doubled in the cited battery life and user complexity for
last year, partly because of investors’ ex- not allowing multiple third-party apps to
pectations that the company has another run simultaneously. Apple may include a
blockbuster coming. But tablets would PA Semi-designed, low-power ARM Cortex
still have to get into consumers’ hands, A9 processor in the next iPhone, which
which makes the price perhaps the most would negate the extra battery drain and
important question.
keep performance at acceptable levels.”
If a tablet doesn’t replace a laptop or
any other gadget, it would have to be inexpensive enough to feel like an accessory, not an investment. And yet it might
also have to come with a speedy cellular
data plan to ensure people can access
content everywhere. That could mean
paying at least another $30 a month
on top of what people shell out for cell
The Tarmac Vaporware Gazette, named in honor of past presiphone, TV and broadband service.
dent Jerry Rowe, is published each month by Smitty’s Printshop,
Kay thinks many people would still likely a non-existant shop specializing in things of little or no importance to the world at large. Send your comments, good or bad,
be interested.
to smittysprintshop@mac.com.
“For this jewel-encrusted status symbol,”
TarMac “Control Panel”
he says, “the answer is absolutely yes.”

Continued from page 3

RUMOR: Next-gen Apple iPhone to
feature LED flash, improved graphics,
third-party apps multitasking
01.09.10
MacDailyNews

“Though most rumors
as of late concern an
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